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Yachtsmen heading for the Antarctic Peninsula 
will first reach the South Shetland Islands after 
crossing the Drake Passage.  Skippers should note 
the advice and cautions in the two Introductions 
and only attempt the voyage in a well found vessel 
and with a strong crew.  They must be totally self 
contained and physically and mentally strong 
enough to cope with the harsh environment and 
fast changing conditions of these isolated waters.

http://maps.google.co.uk/maps/ms?hl=en&ie=UTF8&msa=0&msid=211537501325876235150.00049c77da32e102eb886&t=h&ll=-62.24235,-60.029297&spn=2.799794,11.590576&z=7
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South Shetland Islands

Neptune’s Bellows, Deception Island, looking north

Introduction
The South Shetland Islands form the south side of 
the Drake Passage and lie 480 miles south east of 
Cape Horn. They are separated from the Antarctic 
peninsula by the Bransfield Strait. The group 
extends for 270 miles in an ENE/WSW direction from 
Clarence and Elephant islands in the east to Low and 
Smith islands in the west. They are mainly volcanic 
in origin and lie at the west end of the Scotia Ridge. 
The north side of the islands have many islets, rocks 
and reefs extending off them, but the south side is 
generally clear. The islands lie along the main track of 
the depressions and the winds are equally westerly 
and easterly, depending which side the depression 
passes.

In an average year the islands are largely ice 
free from late December until late March, but ice 

conditions can vary enormously from year to year.
Because of the easy access in summer months and 
the sheltered anchorages, there are many national 
bases here. Not surprisingly, the good anchorages 
often have a base ashore.

Essential reading for visiting the area is Southern 
Ocean Cruising by Sally Poncet and Jerome Poncet.
Warning
The following notes are merely a little information 
that may be of help to fellow mariners. They are in
no way comprehensive and represent only one brief 
visit in the conditions encountered at the time.
The chartlets drawn are nothing more than sketches 
and in no way represent a survey of the coves
and bays. Use them with extreme caution. I have 
purposely not given any waypoints as these tend 
to give an unrealistic accuracy to these notes.
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Elephant Island

Emma Cove
61°04’S 55°19’W

Description
A semicircular bay at the NW corner of Elephant 
Island, with good shelter from the east. The bay 
provides protection from NNW through E to SSW. 
But is wide open to the west.

Approach
When approaching Emma Cove from the west take 
care to pass south of West Reef,  which lies six miles 
west of Cape Lindsey, and is two miles wide. From 
the north it is possible to pass east of West Reef, 
between the reef and the rocks off Cape Lindsey. 
These rocks extend about half a mile off the cape.

Cape Lindsey is the western tip of Elephant Island 
and forms the north side of Emma Cove. It has above 
and below water rocks extending approximately 
half a mile westward from its end. The south side 
of the cove is an unnamed narrow promontory, 
which separates the cove from Mensa Bay. There are 
islets and rocks extending westward from this point 
approximately half a mile. 

Anchorage
Enter Emma Cove midway between the two points 
and head towards a small stream running down the 
scree slope at the south side of the cove. Note that 
there is a larger stream at the north. The beach at 
the head of the cove is divided into two by a small 
headland,off which some rocks extend. Anchor off 
the stream on the south beach in about 8m. The 
holding appeared to be good.

Remarks
The cove is surrounded by black scree cliffs which 
give a rather foreboding atmosphere. Some swell 
was coming into the cove and landing was not 
possible on the beach but the landing shown on the 
sketch chartlet was just about tenable. A few fur 
seals, elephant seals and Gentoo penguins ashore.

Looking NNE from the landing beach
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Bay north of Cape Lookout 
61°16’S 55°11’W
Charts BA 3205 Arg H710

Looking south

Description
An open bay about one mile north of Cape Lookout 
providing shelter from the SSW through W to NNE. 
The bay is completely open to the east and south.

Approach
The approach is straightforward. Cape    lookout and 
Rowett island are conspicuous and this bay is close 
north off a glacier.

Anchorage
Anchor south of the terminal moraine in about 11m.

Remarks
The ease of landing will depend on the swell. If there 
is too much to land on the beach try crossing the 
terminal moraine. The deepest part is to the east of 
the rocks in the middle.

Ashore
There is pleasant walking with a few fur seals, 
elephant seals and Gentoo penguins. This would be 
a good place to anchor to wait if you wish to avoid a 
cruise ship visiting Cape Lookout. 

Elephant seals
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Cape Lookout Cove 
61°17’S 55°12’W
Charts BA 3205 Arg H710

Looking SE

Description
A small cove to close west of Cape Lookout and 
protected on the south side by Rowett island. Good 
shelter from all but SE winds.

Approach
Straightforward approach from the east. From the 
west and south pass south and east of Rowett island. 
The beacon on Cape Lookout is not conspicuous.

Anchorage
Enter the cove midway between Cape Lookout and 
Rowett island. Anchor off the beach in about 10m. 
The cove is small enough to take lines ashore if 
required.

Remarks
Land as convenient on the boulder beach at the 
north side of the cave. There is a large Chinstrap 
penguin colony ashhore with other associated birds. 
Also Fur and Elephant seals. Cruise ships call here. 
There is a narrow passage between Rowett island 
and the spur of land forming the west side of the 
cove. There is a drying rock in the middle of the 
narrowest part. This cove is a delightful spot.

Elephant seals wallowing with Chinstrap penguins and chicks 
behind
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Gibbs Island
Cove close to The Spit 
61°29’S 55°26’W
Charts BA 3205 Arg H710

Looking ESE

Description
A small cove on the south side of Gibbs Island giving 
shelter from the S through W to ENE.

Approach
The approach is straightforward from the south side 
of the island. Head towards The Spit, The cove is 
close west of it. The Spit is a narrow boulder isthmus 
joining the two parts of the island towards the east 
end.

Anchorage
Anchor in about 8m off the snow slope.

Remarks
Land on the beach at the foot of the snow slope and 
also on The Spit, swell permitting. Ashore there is a 
large chinstrap colony. Well worth a visit.

Leopard seals on icefloe
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King George Island
Mersey Spit and Penguin Island 
62°05’S 57°52’W 
Charts BA 3205 1774 Chile 14000

Looking south

Description
Mersey Spit and Penguin Island forms the east side 
of King George Bay. The bay between Mersey Spit 
and the Three Sisters rocks provide shelter from W 
through N to NNE. An anchorage off the NE side 
of Penguin Island gives protection from the SW 
quadrant. 

Approach
The approach is straightforward passing to the east 
of Penguin Island.

Anchorage
Anchor NE of Mersey Spit in about 7m. If the wind 
goes south of west, Penguin I will provide protection 
from the wind but the ice from King George Bay, 
passing north of the island may well cause problems 
in this anchorage. In this case shift berth to Penguin 
Island. Anchor in about 9m at the north end of the 
shingle beach. Conversely, if the wind is in the NW, 
better shelter from ice will be NW of Mersey Spit.

Remarks
A large part of the land around Mersey Spit is ice 
free and consequently there is good walking ashore. 
Land on the beach as convenient. A few seals ashore. 
Penguin Island is also ice free and good walking. 
Here is a popular stop for cruise ships. The trail up to 
the crater rim is marked! There is a Chinstrap colony, 
as well as Giant Petrels and Antarctic Skuas nesting. 
Well worth a visit.

Note
A shallow spit joins Penguin Island to Mersey Spit. 
There are rocks off both points. China Moon crossed 
over it into King George Bay. I passed midway in the 
channel and found a minimum of 2m. The water 
was very murky and it was impossible to see if there 
were any rocks. I 
would certainly 
not recommend 
this passage, 
but if it is 
attempted then 
do so in calm 
conditions with 
no swell and a 
rising tide.

The crater, Penguin Island
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Potter Cove, Maxwell Bay 
62°15’S 58°41’W
Charts BA 1776 Chile 1407 1410

Description
Potter Cove, at the SE side of Maxwell Bay (called 
Bahia Fildes on Chilean charts), provides shelter from 
winds from virtually all directions and is regarded as 
one of the best anchorages in the South Shetlands.

Approach
The 196m high Three Brothers peak, which is 
conspicuous, stands at the east side of the entrance 
to the cove. If approaching from the east, take care 
to avoid the rocks and shoals extending 2M from 
the SE entrance to Maxwell Bay.Once round these 
rocks keep at least half a mile from the eastern shore 
as you approach the cove. The NW shore, at the 
entrance to the cove, should also not be approached 
to closely. Approaching Maxwell Bay from the SW 
avoid the rocks and shoals extending 1.5 miles west 
of buthoit Point, the SW point of Maxwell Bay.

Anchorage
With winds from E through S to WSW, the best 
shelter is found off the base, at the S side of the 
cove. Anchor in about 5m. In northerly winds, better 
shelter will be found off the north shore of the cove 
close west of the end of the glacier. Anchor in about 
6m, appeared to be good holding. Take great care 
to sound around the anchorage because there are 
some drying rocks close south of this anchorage. Ice 
from the glacier could be a problem.

Remarks
Jubany is an Argentine scientific base. Land on the 
beach by the base. Much of the land to the west 
of the base is ice free, but take care to avoid the 
SSSI along the west and south shore of the Potter 
peninsular.

Looking north

Helicopter landing site, with Three Brothers Peak behind
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Ardley Cove, Maxwell Bay 
62°2’S 58°55’W
Chart BA 1776 Chile 1407 1410

Looking east

Description
Ardley Cove lies in the NW corner of Maxwell Bay, 
It provides good shelter from all winds except those 
from the eastern quadrant.

Approach
See Potter Cove for Approach to Maxwell Bay. 
Except close to the shores of Maxwell Bay the only 
obstruction to avoid in the bay are the Ras Rocks, 
lying in position 62°13’S 58°51’W. Pass north of 
Ardley Island and the rocks close NE of it.

Anchorage
Becerra Island lies at the head of Ardley cove. A 
shallow spit runs from it, in NW direction, to the 
shore. The least depth on this spit is 0.4m. The best 
anchorage will be found by passing north of Becerra 
I, and anchoring north of the spit in about 3 or 4m. 
SW of the spit the bottom is deeper, much of it 
between 10 and 20m.

Remarks
Land at the head of the bay off the bases. The Chilean 
base President Frei is at the south end of the beach. 
To the north of it is the Russian base Bellinghauser. 
The Chileans run an air service to Punta Arenas and 
it should be possible to organise a flight. They also 
have a post office, open 2 days a week. This is the 
major Chilean base. The Russians have recently built 
an Orthodox Church on the hill overlooking their 
base

Russian Orthodox chapel close to Russian base, Bellinghauser
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Roberts Island
Coppermine Cove 
62°23’S 59°40’W
Charts BA 1776 1774 Chile 1405 1406

Description
Coppermine cove lies at the west end of Roberts 
Island and on the NE side of the English Strait 
(separating Roberts I. from Greenwich I.) This cove 
gives shelter from the N and E.

Approach
Approaching from the SE is straightforward. 
Coppermine Cove is identified by the conspicuous 
3 peaks of The Triplets, just over 1 mile SW of the 

cove. Note that only 1 mile NW of the cove are the 
narrows of the English Strait, which have strong 
currents and overfalls.

Anchorage
On entering the cove the soundings decrease rapidly 
from over 1000m to 20m. Anchor in about 5m.

Remarks
Ashore is a small Chilean scientific base. It is only 
manned in the summer and the party of five are 
studying plant biology. Note that the SSSI starts close 
west of the buildings.

Chilean summer base
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Greenwich Island
Iquique Cove, Discovery Bay 
62°29’S 59°40’W
Charts BA 1774 Chile 1405 14270

Looking west

Description
Iquique Cove lies on the eastern side of Discovery 
Bay (Chile: Bahia Chile). The cove is completely land 
locked and provides complete shelter. It is very tricky 
to enter the cove.

Approach
Approaching Discovery Bay from the English Strait is 
straightforward. When approaching the cove keep 
well west and south of the Bajo Torro reef which 
extends 650m out from the Peninsula Guesalaga 
(the NW side of the cove. Entering the cove is 
difficult. It is shallow and there are rocks. The large 
scale Chilean chart, 14270, is wrong with regard to 
the entrance. Once south of the Bajos Torro Head for 
the south side of the Guesalaga Peninsular until the 
northern tip of Gonzalez Island bears 094° Magnetic. 

Head towards the northern tip on this heading until 
very close to the island. A beacon on the south end 
of Boris island should be identified. Head towards 
the beacon on a bearing of 030° magnetic. Before 
getting too close to Boris I., when about in the 
middle of the channel between Boris I. and the 
Guesalaga peninsular, turn to port to enter the inner 
part of the cove. 

The route used by the Chilean Navy to enter the 
cove is to approach the east end of Gonzalez Island 
on a bearing of 100° Magnetic and then hug the 
NW shore of Gonzalez I. until the beacon on Boris I. 
bears 030° Magnetic. I left the cove by this route and 
had a minimum depth of just over 4m. This route is 
not as straightforward as the first one described. I 
would strongly recommend that the route in should 
be reconnoitred by dinghy. At the very least go in 
very cautiously, on a rising tide, near high water and 
very slowly.

Anchorage
Once in the inner part of the cove, anchor in the 
middle in about 5m. When visited in 2004 I used a 
mooring close to Boris I. As the Navy are leaving it 
may well be missing in Future. Land at the jetty or on 
the beach.

Remarks
In 2004, the Chilean Navy were evacuating the base. 
Its future is unclear. 
Apart from the 
base there is little 
of interest ashore.

Crabeater seal
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Looking east

Description
On the east shore of Livingston Island is Moon Bay, 
facing McFarlane Strait. Half Moon Island lies in  the 
SE corner of Moon Bay. It provides excellent shelter 
except from the east.

Approach
Approaching from the east, keep clear of the Rugged 
Rocks which extend NW of Renier Point, the eastern 
extremity of Livingston Island. Off both points of the 
entrance to the crescent shaped bay (of Half Moon 
I.) lie rocks, so give both a reasonable berth.

Anchorage
Anchor west of the base in about 5m. Note the 
rocks shown on the sketch chart to the south of the 
anchorage. Land on the pebble beach in front of the 
base.

Remarks
A seasonal light is exhibited on the SE point of the 
island, but it is not to be relied upon. Also on the SE 
point is a Chinstrap rookery and on the beach below 
it is a slowly decaying clinker built boat. This is a 
popular stop for cruise ships. Well worth a visit.

Livingston Island
Half Moon Island 
62°38’S 59°55’W 
Charts BA 1774

Chinstrap penguin feeding chick
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Deception Island
Baily Head 
62°58S 60°30’W
Charts BA 3202 1776 Chile 1402

Looking east

Description
An anchorage close north of Baily Head, which is the 
eastern extremity of Deception I. Good shelter from 
westerly winds.

Approach
The approach is straightforward. Baily Head and the 
Sewing Machine Needles rocks are conspicuous.

Anchorage
Anchor off the shingle beach in about 9 m. In strong 
westerly winds willywaws come off and around Baily 
Head. These can be avoided by anchoring about 0.5 
miles north of the Headland. The best landing is on 
the beach, in the corner by the headland, close to a 
stream.

Remarks
Up the valley of the stream is a large Chinstrap 
rookery. This is a popular stop for Cruise ships

Stream and Chinstrap penguin rookery
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Whalers Bay 
62°59S 60°32’W
Charts BA 3202 Chile 1402

Looking south

Description
Inside the crater, just past Neptune’s Bellows, 
Whalers Bay lies at the SE side of the crater. It 
provides shelter from the north and east but the 
holding is reported to be poor.

Approach
Neptune’s Bellows is the entrance channel to 
the crater and the approach from the south is 
straightforward. In the middle of the channel lies 
Ravn Rock, with 2.4m over it. This is best avoided 
by keeping to the northern half of the channel, 
which is deep. There 280m between Fildes headland 

and Ravn rock. The rock is also covered by the red 
sector of the Collins Point light. Neptune’s Bellows is 
named for the strong gusts that often blow through 
the channel which may well make tacking through 
difficult. Once past Fildes Point head into Whalers 
bay, there are no obstructions.

Anchorage
Anchor off the head of the bay to the west of the 
whaling factory. The bottom rises rapidly close to the 
shore. Anchor on the shelf in about 4m. The bay has 
a reputation for poor holding. Land on the beach.

Remarks
It is very interesting ashore with the remains of the 
BAS base, hangar and Beaver ‘plane which were 
damaged and abandoned in the 1969 eruption. 
There are also the remains of the whaling factory, 
On the beach to the south of the factory are piles of 
oak barrels and a whale flensing (blubber removal) 
boat. This is a popular stop for cruise ships. Well 
worth a visit.

remains of factory at Whalers Bay
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Antarctic Peninsula
Introduction
A trip to Antarctica in your own boat is likely to 
prove the cruise of a lifetime, but involves a lot of 
homework.

Visitable areas 
In yachting terms ‘the Antarctic’ means the islands 
flanking the Antarctic Peninsula, probably with a 
landing at one of the few accessible points on the 
Continent itself - just to prove that you were there! 
The season runs from November to March. At 
present the visitable area is largely confined to the 
west side of the Peninsula because the break-up of 
the Larsen Ice-shelf has filled the Weddell Sea with 
so much loose ice that even cruise ships are rarely 
going there. 

Tourism
Visitors by private yacht constitute a tiny fraction 
of the annual total. In the 2006/07 season 55,000 
tourists landed from cruise ships in the Peninsula 
area, many of them at up to ten different places. In 
2003 the total number of landings was estimated 
at 104,000 and has certainly risen substantially. 
Alongside this, a fleet of about 15 charter yachts 
make trips with 6-10 ‘guests’ during the season; and 
a total of perhaps a dozen private yachts visit in any 
one year. 

Antarctic trips tend to start and finish in Ushuaia. 
Cruise ships go directly across the Drake Passage but 
most small craft stop in Puerto Williams in order to 
collect a Chilean zarpe which enables them to shelter 
in Chilean anchorages on the way to or from the 
Drake Passage if necessary (It often is). The normal 
visitor beat stretches along the Bransfield and 
Gerlache straits between the spine of the Peninsula 
to the east and the chain of islands to the west. 
Hitherto the bulk of visitors have not gone south of 
the Argentine Islands (65º 15’S). Only nine of the 
79 sites described in the Oceanites Compendium 
(a guide produced in collaboration with the cruise 
industry – see book section below) lie south of here. 

Few cruise ships go further. Some charter yachts 
do so, in particular those hosting climbers, divers, 
and others with specialist interests and deep 
pockets; likewise a sprinkling of fortitudinous private 
yachts The constraints are various: Conditions are 
harsher, the charts are less accurate or non-existent, 
safe anchorages are few and, above all, the ice 

conditions are unreliable so that access may become 
impossible and schedules likely to be disrupted. 
With the march of global warming, the last obstacle 
shows signs of literally melting away and the tourist 
area seems certain to extend. 

There are a good number of places throughout 
the Peninsula area which are designated by 
international agreement as sites of scientific interest 
to which access is limited or forbidden. Depending 
greatly on the actual route, a round trip from 
Ushuaia to the Vernadsky base in the Argentine 
Island will be in the region of 1500 to 2000 miles. 
A more ambitious trip southward, say to Marguerite 
Bay, would add around 500 miles. Once in Antarctic 
waters most of the sailing will be by day. Allowing 
a week each way for the journey to and from the 
Peninsula it does not make much sense to plan for a 
trip of less than a month, or a week or two longer if 
you want to see how far south you can get or want a 
good reserve of ‘bad weather’ time. 

All of which said, when conditions permit and 
time is available a cruise in the south of the area 
is correspondingly more rewarding than a visit 
confined to the north. And you can have the place to 
yourself. (In January, 2007 Sadko saw only one other 
visitor – a small charter yacht – in the 11 days she 
spent between Vernadsky and the Antarctic Circle).

Formalities
Activities anywhere south of 60ºS are regulated by 
a far-reaching series of international agreements 
known collectively as the Antarctic Treaty System. 
Citizens of States party (in practice more-or-less 
everybody) require the authorisation of their own 
government to visit the Treaty area. Even among 
serious governments there is a wide difference of 
approach to this requirement. Some appear to do no 
more than register the intended voyage, while others 
may make searching enquiries about the vessel and 
the experience of the crew. The British Foreign and 
Commonwealth Office require six months notice. 
The procedure involves a sequence of questionnaires 
(20 pages in all, plus supporting documentation) 
concluding with the requirement to register your 
humble sailing trip as a ‘British Expedition to 
Antarctica’ with a formal announcement to that 
effect in The London Gazette. There is no direct 
charge but the Gazette announcement costs £80. 
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With luck the result will be the issue of a bound 
‘permit’. And applicants are warned that proceeding 
without a permit or breach of a permit condition ‘IS 
A CRIMINAL OFFENCE PUNISHABLE BY UP TO TWO 
YEARS IMPRISONMENT AND/OR AN UNLIMITED 
FINE’. Reference: www.fco.gov.uk. Look for Guidance 
for Visitors to Antarctica.

Emergencies; Search and 
Rescue
It is highly unlikely that insurance can be obtained for 
the yacht itself in Antarctic waters. But responsible 
governments are now insisting on insurance cover 
for the rescue of crew members, somewhat along 
the lines of that required by the Norwegians for a 
permit to visit Spitzbergen. But there is an important 
difference: Nobody actually administers Antarctica, 
despite the pretensions of a number of governments 
including HMG, and there are no Search and Rescue 
(SAR) services as such. However during the season, at 
least in the northern part of the Peninsula area, there 
is a light rain of cruise ships and a drizzle of Naval, 
scientific and supply vessels from various countries, 
plus a few yachts. With any luck one of these craft 
might be within reach to respond to a distress call, 
with the consequent likelihood of a ‘human salvage’ 
claim or a demand for the reimbursement of costs. 
Further south is a different matter. When the cruise 
ship Explorer sank in November 2007, could the 150 
people on board have been rescued if she had been 
at the southern end of Crystal Sound, no matter 
what insurance was in force? So what prospects for 
a small yacht? 

In the 2007-2008 season, an American yachtsman 
guaranteed in advance the necessary funding for a 
rescue flight to be made by the small Chilean airline, 
DAP. But DAP fly only into the Chilean base in the 
South Shetlands, so this arrangement would seem to 
solve only part of a problem if it arose elsewhere on 
the Peninsula.

This appears to be a grey area. Meanwhile, for 
what it is worth, in 2006 members of Sadko’s crew 
obtained insurance which satisfied the Foreign Office 
through the British Mountaineering Federation and 
from International Health Insurance, Danmark, a/s 
Palaegade, DK-1261, COPENHAGEN K Tel: 45 33 15 
30 99. Fax: 45 33 32 25 60. e-mail: ihi@ihi.com 

The following list of other specialist Brokers for 
travel insurance was supplied in 2006 by agents who 
had not themselves been able to help: 
Aon Risk Services - 01703 225616 

Agency Underwriting Ltd - 01206 577770 
Bordengate Insurance - 08456 580560 
Crispin Speers Ltd. - 0207 480 5083 
Harrison Beaumont Ltd - 01993 700200 
P J Hayman & Co Ltd - 0845 602 0020 
Hiscox PLC - 0207 448 6000
IMG Europe Ltd - 01273 384925 
MRL Insurance Direct - 0870 870 4401 
Norwich Union - 01603 622 200 
West Midland Brokers - 01432 268 301 
Perry, Gamble Ltd. - 01404 830 100 

Politics
Argentina, Chile and the United Kingdom each 
claim triangular areas (‘sectors’) stretching to the 
South Pole which overlap and cover the bulk of the 
Peninsula area. The Antarctic Treaty provides that 
no new claims to sovereignty in the area may be 
advanced. It also states that while nothing in the 
treaty shall affect existing claims, no activities taking 
place there shall serve to support an existing claim. 
This does not seem to inhibit a good deal of activity 
which can have little purpose other than to assert 
national presence. For example the Argentines 
and the Chileans each purport to administer ‘their’ 
sector as if it were physically part of the motherland, 
and it seems that most citizens of the two countries 
believe that the Peninsula is indeed a normal 
province of their country. HMG is not so well placed. 
It may surprise even some readers of these notes to 
know that the area concerned is a United Kingdom 
Overseas Territory, with senior officials of the 
Foreign Office acting as the territory’s Commissioner 
and Administrator. The Times Atlas, with touching 
patriotism, styles these areas ‘British Antarctic 
Territory’, ‘Chilean Claim’, ‘Argentine Claim’ (author’s 
italics).

There is a lighter side to this gallimaufry: If you 
visit an Argentine base built on ‘British’ territory in a 
British-registered vessel should you fly an Argentine 
courtesy flag? Throughout her 2007 cruise Sadko 
flew only the ‘Antarctica’ flag (a silhouette of the 
continent) from the starboard cross-trees. During 
the visit to their Jubany base the Argentines were 
charming to us but remonstrated with our (Chilean!) 
Spanish-speaker about our alleged discourtesy in 
failing to fly an Argentine courtesy flag. A similar 
point had been made when we earlier visited a 
Chilean base. Both of them evidently meant it 
seriously. 

http://www.fco.gov.uk
mailto:ihi%40ihi.com?subject=
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Published in 2003 by Oceanites Inc. PO Box 15259, 
Chevy Chase, MD 20825, USA. On sale in Ushuaia 
in book and CD format. 

• Secondly there is a collection of assorted 
sketch plans and notes circulating in photocopy 
among the charter skippers in Ushuaia, termed 
Borrowed Notes in this paper. Versions vary but 
key information about anchoring conditions and 
resources for about 50 credible stopping places 
are covered. Many of the items are very scrappy 
but the collection is invaluable. Some of the 
charter skippers are jealous of this material but it 
is strongly recommended to enquire discreetly for 
someone willing to lend a copy for photocopying. 

• Thirdly is Southern Ocean Cruising by the very 
experienced Jerome and Sally Poncet. A second 
edition was published in November 2007 by 
Environmental Research and Assessment Ltd, 
CAMBRIDGE, England (www.era.gs) on the 
initiative of, and apparently at the expense of, 
the British Foreign Office. It includes a good 
description of relevant sections of the Antarctic 
Treaty system and the role of the International 
Association of Antarctic Tour Operators (IAATO), 
together with general advice, especially about 
conduct ashore in this delicate environment, and 
a generous list of sources of information including 
web sites. The book is made available by the 
Foreign Office to those applying to them for visitor 
permits, and it may be purchased for £12.99 from 
the Scott Polar Research Institute, Lensfield Road, 
CAMBRIDGE CB2 1ER, ENGLAND. 

• For the area of Ushuaia and the route as far as 
Cape Horn, detailed guidance is available in: 
Chile, by Andrew O’Grady, published by the RCC 
Pilotage Foundation and Patagonia and Tierra del 
Fuego, by Mariolina ROLFO and Giorgio ARDRIZZI, 
Editrice Incontri Nautici, (‘the Italian book’)

• There is also a recent publication entitled 
Antarctica: Navigation Guide/Guia de Navigation, 
by Artura de la Barrera Werner (adwerner@emol.
com), published by Litogar S.A. ISBN 956 291 
671-5. The book has parallel Spanish/English text 
and covers the whole of Antarctica. From very 
brief acquaintance, it appears to be part-way 
between an HO pilot book and a small boat guide. 
User reports required.

[A general word about the charter fleet: Although 
the skippers are generally friendly and/or helpful 
with some one detects an underlying disapproval of 
amateur yachts. This is understandable if they fear 

Sources of Information
Books
Antarctic publishing is currently a growth industry, 
but here are some recommendations: 

General
• The first essential reading is Antarctica, in the 

Lonely Planet series. Aimed principally at the 
commercial tourist but providing an outstanding 
introduction to all aspects of a visit to the 
Continent. Includes a reading list. 

• The Crystal Desert by David G Campbell. 
Informative description of, and reflections on, 
many aspects of the Peninsula area by literate 
scientist. Fascinating. 

• Southern Lights. John Rymill, readable account 
by the leader of the small and highly-successful 
British Graham Land Expedition, 1934-37. 

• Below the Convergence. Alan Gurney. Somewhat 
discursive but well-selected anthology of accounts 
of journeys is search of Antarctica up to the mid-
19th century.

Wildlife
• Antarctica, A Guide to the Wildlife. Tony Soper, 

Bradt Travel Guides. Excellent introduction to the 
subject. More specialist books are:

• Birds of Patagonia, Tierra del Fuego and Antarctic 
peninsula; the Falkland Islands and south Georgia. 
E Couve and C Vidal, Editorial Fantastico Sur, 
Punta Arenas, Chile. Serious ornothologists’ field 
guide. Parallel text Spanish/English. (Available in 
Ushuaia)

• Marine Mammals Patagonia Antarctica, Ricardo 
Bastida-Diego Rodrigues, Vazquez Mazzini 
Editores, Argentina. English edition 2005. ISBN 
987-9132-11-4 (Available in Ushuaia)

Nautical
There is as yet no yacht-cruising guide to the 
Antarctic. Some useful information will be gleaned 
from the recent Admiralty Pilot (2003, and again 
under revision), but there are three works which are 
of serious help in deciding where it is interesting and 
feasible to go, and what to expect:
• The Oceanites Compendium: Essentially a travel 

industry/NGO publication aimed at tour operators 
and environmental monitors, with voluminous 
statistics about their activities. But is a useful 
resource because it includes potted descriptions 
of 79 established ‘Visitor Sites’ (and statistics 
about a total of 275!) in the Peninsula area. 

http://www.era.gs
mailto:adwerner%40emol.com?subject=
mailto:adwerner%40emol.com?subject=
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Weather; forecast facilities
The weather on the Peninsula is a function principally 
of the depressions which stream across the south 
Pacific Ocean and funnel into the Drake Passage, 
as part of the circumpolar flow. The procession 
is erratic and influenced by a number of factors, 
including movements of the South Pacific ‘High’. 
The prevailing winds are of course westerly, but the 
winds most feared by small boats are the – happily 
rarer – strong easterlies, swirling off a depression to 
the north.

With a good HF set the radio weather faxes 
transmitted from Valparaiso by the Chilean 
Armada are commonly readable as far south as the 
Antarctic Circle. With the exception of one evening 
transmission, they are situation reports rather 
than forecasts but read consistently they provide a 
good idea of how the weather is developing. There 
are also Chilean ice charts but since they are only 
updated weekly they are of less value.

For a true forecast up to five days ahead there 
are the Buoy Weather reports and Grib Files 
receivable as automated e-mails. The latter offer 
more comprehensive coverage. Although they are 
computer- generated models they are frequently 
updated and are usually very near the mark.

To supplement this ‘Bob’, (Bob McLeod) an 
amateur meteorologist and radio HAM in the 
Falklands, was in 2006/7 kindly running a service 
for yachties who checked in with him. (at 1000 
and 2200 UTC, on 3.790 MHz LSB, with 7.044 MHz 
USB and 14.130 MHz as alternate frequencies) He 
offered pre-digested forecasts for specified positions 
on demand. His equipment is excellent and he was 
often able to provide relays for our daily ‘sched’ with 
the Patagonian Cruisers Net (see below) 

Patagonian cruisers net
This is a long-established English-language yachtie 
radio net, currently run by Wolfgang, a German 
yachtsman who has settled near Villarica in Chile. 
The net operates on a maritime HF channel (8.194 
MHz) daily at breakfast time (1300 UTC) and is a 
valuable source of information, companionship and 
occasional emergency assistance. Most participants 
are on boats sailing somewhere along the coast 
between Uruguay and Valdivia in Chile, but they are 
encouraged to continue to take part if they leave 
for Antarctica: strongly recommended. The further 
south, the more erratic the reception and the greater 
the use of ‘relay’, but Wolfgang tries to get a daily 
position and ‘safe and well’ report from everybody.

that less-experienced and less well-equipped visitors 
will get into trouble and have to be assisted by them; 
or that there will be a serious incident which would 
draw unwelcome attention to yachts in general. 
The latter point because there is a suspicion on the 
dockside in Ushuaia that a number of governments, 
and probably the IAATO, regret that any small craft 
go south. But it is difficult to take seriously the 
complaint I have heard that visits by a tiny handful 
of private yachts are undermining the charterers’ 
market].

Some websites (there are dozens)
www.fco.gov.uk Foreign and Commonwealth Office 
(for official publications and applications for a
permit to visit)
www.spri.cam.ac.uk Scott Polar Research Institute
www.antarctica.ac.uk British Antarctic Survey (BAS)
www.ukaht.org The United Kingdom Antarctic 
Heritage Trust
www.lonelyplanet.com Useful for links to other 
sources
http://70south.com somewhat untidy site but with 
lots of useful reference material
www.polarnews.com Polar News

Charts
The Peninsula is an area where, for once, it is 
worth having the best charts available. Coverage is 
provided by both the British Admiralty (13 charts) 
and the DMA (16). The pattern of coverage and the
scales used are different and it is worth looking 
carefully at the two catalogues. (Note in particular 
that south of 66ºS until you get to Marguerite Bay 
the two relevant BA charts are on the scale of only
1:500,000 and the three DMA charts are at 
1:200,000). Probably the most important thing is 
to have the latest published chart, from whichever 
source. New editions do not appear frequently so 
this should not be too costly. Where one exists (e.g. 
the recent BA chart 3575 for the area around the 
Argentine Islands) it can be a striking improvement 
on its predecessors.

Apart from the sheets of ‘Plans’ (BA 1774 and 
3213; and DMA 29107) and insets on four others, 
most of these charts are at scales between 1:100,000 
and 1:500,000 and are accordingly of precious little 
help for small boat pilotage. Hence the importance 
of the informal material referred to above.
N.B. The author of these notes has not had the 
opportunity to compare the above Anglo-Saxon 
charts with the available Chilean and Argentine 
charts.

http://www.spri.cam.ac.uk
http://www.antarctica.ac.uk
http://www.ukaht.org
http://www.lonelyplanet.com
http://70south.com
http://www.polarnews.com
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Boat equipment: non-exhaustive list
Ground tackle
Have at least one anchor which is ‘overweight’ for 
the boat by standard norms, and of course an all-
chain rode. This in preference to multiple anchors 
when this can be avoided. Opinions are divided 
about ‘tandem’ anchoring. Very few anchorages 
in Antarctica are safe in all conditions. If the wind 
changes direction unexpectedly and/or serious ice 
moves in you may need to make a rapid departure, if 
only across the bay. 

Shore lines
Anchoring space is frequently limited and shore 
lines are the norm. Take at least four 100m lines 
in 18-20mm polypropylene with soft eyes in one 
end. Some people recommend fitting them in 
reels mounted on deck, if you have space to install 
them. But heavy-duty open weave bags, into which 
lines are flaked, can be moved around as needed 
and taken in the dinghy; also stowed below when 
cruising in waters where they are not required. In 
an emergency, ‘free’ lines can also be cast off from 
the boat more easily for later retrieval. Note that 
although floating lines are usually preferable, when 
there is much ice a nylon or polyester line which 
sinks clear can be of more use. So it is worth having 
one or two readily available.

The following tip is taken from the Pilotage 
Foundation Web Pilot on South Georgia by Andy 
O’Grady:

‘Strong williwaws are common and can make life 
uncomfortable when the vessel is unable to swing 
into the wind.  A way round this is to take the 
shorelines to the anchor chain and then let out 
chain until the lines are below the vessel.  If using 
polypropylene lines (which are recommended 
as they float and collect less kelp) then they will 
need to be weighted close to the vessel to keep 
them from fouling the keel.’

• For attaching lines: at least four wire strops c 5m 
long and having eyes without thimbles (which 
get caught on rocks) spliced in both ends. One 
eye should be smaller so that it can be passed 
through the other. Chains for the same purpose 
are stronger but less convenient to handle. (Sadko 
used both). 

•	 Jumbo shackles for use with above gear.
• A few climbers’ pitons and angle-iron ice/beach 

stakes (and a hefty mallet). Not often used but 

Practical Matters 
Assistance in Ushuaia
Recommended contact: ‘Ushuaia Logistics’ is a small 
agency run by Roxanna Diaz Selby which provides 
assistance of all kinds to visiting yachtsmen. 
Roxanna, who speaks excellent English, also French, 
helps in obtaining supplies, arranging for repairs and 
services, dealing with the Authorities, and will run 
errands and provide general advice. Roxanna has 
recently also been appointed as the ‘Port Officer’ 
of the Ocean Cruising Club and the ‘Cruising Station 
Host’ for the Seven Seas Cruising Association. E-mail: 
rox@xaxero.com;  Phone: (02901) 433364; Mobile: 
(02901) 156000264

The boat
The yachts taking charter guests to the Antarctic are 
made of metal, often aluminium, have swing keels 
and retractable rudder(s), enclosed dog-houses, 
thick insulation above the waterline, central heating, 
mast steps and/or ratlines; and various other 
features such as installed drums for shore-lines or 
separate water tanks for drinking and domestic 
water. Few amateur yachts are likely to match this. 
Nor, for a one-off visit, is it all necessary. A number of 
well-found GRP boats have been safely to the more 
frequented and better charted areas in the north. 

Further south and/or off the beaten track one 
needs to think more carefully. In the light of hindsight 
this author would not again take Sadko, which has 
a strong aluminium hull but a fixed two-metre keel 
and an unprotected semi-balanced rudder, south of 
Vernadsky except in company with another yacht (as 
was, in fact, our original intention in 2007).
In any case some features are almost essential: 
• A protected watch-keeping position by means of 

a deck-house, a partly-covered cockpit, or a deep 
rigid spray-hood; 

• serious insulation of the hull and deck; 
• a cabin heater, where a drip-feed diesel model is 

preferable to blown hot air. Although it requires 
a chimney and will often not work under way, it 
is far simpler and more reliable and does not 
consume high amperages every few minutes as 
the thermostat switches in and out. Remember 
that you will usually be at rest overnight.

• mast-steps and/or ratlines in order that a lookout 
may readily get aloft.

• double glazing (Good DIY kits sufficient) 
• Blackout screening for windows/portholes also 

useful. (black cardboard sufficient)

mailto:rox%40xaxero.com?subject=
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to hold them. Good quality, large (20 or 30 litre) cans 
are not reliably obtainable in Ushuaia. 
In Ushuaia there is no alongside re-fuelling 
practicable for a small vessel and diesel is normally 
collected in cans. It is often possible to do this jointly 
with another yacht so sharing the cost of the pick-up 
truck (flete). Alternatively, the YPF fuel company 
will deliver diesel in 40 gallon drums and Ushuaia 
Logistics can provide a portable electric pump and a 
long hose. 

Water
on the dock in Ushuaia and Puerto Williams. 
Thereafter adequate fresh water will be obtainable 
from glacier melt. But the availability of suitable 
places, which obviously have to be uncontaminated 
by wildlife, is variable and every opportunity should 
be taken to keep the tanks full. 

Victualling
Get almost everything in Ushuaia, and maybe top up 
in Port Williams (very limited fare). There is a huge 
ANONYMA supermarket on the outskirts of Ushuaia 
and several useful shops nearer at hand. Note that 
canned meat is unobtainable in South America 
(where most of ours comes from) but that excellent 
cuts of fresh meat can be vacuum-packed to order 
in convenient-size chunks. The shelf-life is nominally 
one month but if the packs are stowed against 
the hull in Antarctic waters this can be liberally 
interpreted. Some larger yachts also take whole lamb 
carcases suspended in the rigging. The weak link is 
fresh fruit and vegetables. These are all brought to 
Ushuaia in containers, no doubt environmentally-
controlled, and do not last as well as real fresh food 
when exposed to the natural world. 

Personal kit: Some tips
• HD gumboots for shore-going (sea-boots too 

delicate, and their fussy soles collect grit and 
penguin goo) Cheap in Ushuaia. Get them big 
enough to leave space for heavy insoles.

• Waders, useful for choppy landings (also cheap in 
Ushuaia)

• A helmet-form fleece or quilted hat, i.e. covering 
the neck and ears and closing under the chin.

• A heavy fleece neck-gaiter, aka ‘turtle neck’, which 
is less bulky and more efficient than a scarf.

• In additional to heavy thermal underwear, extra-
lightweight polypropylene wear which is very 
quick-drying has been found useful.

• Gloves: There is no ideal answer. Avoid lined 
waterproof gloves which never dry out. Try cloth-

invaluable when there are no obvious rock holds.
•	 A second tender: Consider what you would 

do if a shore party’s dinghy was swept away or 
damaged. (This is real: In 2006 a cruise ship had to 
rescue yachtsmen whose dinghy was savaged by 
elephant seals in South Georgia!)

•	 Emergency shore package: Depending on the 
extent of shore visits it may be wise to take ashore 
a waterproof bag containing survival blankets, 
first aid, food, water etc.

• If you already have scuba gear and there is space, 
of course take it. Otherwise snorkelling kit, with a 
dry suit or at least one wet-suit with helmet and 
gloves.

•	 Communications: Unless you already have several 
hand-held VHF sets it is worth getting walkie-
talkies for contact with shore- and line-laying 
parties etc. But they need to be good ones which 
hold their charge and actually work up to their 
advertised range.

•	 A sturdy brush on a handle, suitable for scrubbing 
shore-detritus from boots before returning to the 
ship. (The good tour operators are meticulous 
about doing this)

•	 Water funnels of various sizes; and, say, 3-4m 
lengths of 20-25mm plastic pipe for filling water 
carriers from glacier run-offs. 

• A stout pile-board and three or four motor tyres
•	 A short-handled spade or shovel may be useful; 

and is essential if you want to dig a hot-water 
pool in the sand at Deception Island, in the best 
tradition of cruise-ship punters!

•	 A hand-held depth sounder for sounding from 
the dinghy, and as a stand-by. To be without a 
working depth-sounder would be a very serious 
limitation.

•	 Spares, medical kit etc. No special requirements 
for the Antarctic beyond the obvious point that 
there is no way of obtaining anything which is not 
on board when you leave Puerto Williams. 

Stores 
Fuel
You may need a lot of it. It cannot even be assumed 
that it will be possible to go under sail out to or back 
from the Drake Passage. Once across the Passage 
there will be only limited opportunities for sailing 
and for the purpose of calculation it is best to 
assume that you will do the whole of the Peninsula 
sector under power. The cabin heater also consumes 
diesel. Most boats calculate that deck cans are 
necessary and if so it is worth confecting sturdy racks 
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backed industrial/DIY rubber or plastic gloves, 
worn over separate thin fleece, silk or cotton 
gloves. Get them both with and without gauntlets 
for different uses. Also some ski-type gloves (not 
leather) for dry conditions.

• Photography: A committed photographer will no 

doubt need his SLR. But it can be a pest on shore 
trips in difficult conditions. Consider a compact 
camera which can be closed up and stuffed into 
a pocket with one hand. But if digital, beware 
the very small ones which are fiddly to hold and 
operate with cold hands.

Sadko’s route

Plan by Acanthus Digital



24

Anchorage and Port Information
Places visited by Sadko in January-February 2007. Chart References are to the largest-scale charts for the 
places concerned published by the British Hydrographic Office or the DMA. The coordinates record Sadko’s 
actual resting places.

1. Melchior Islands 
Gamma Island
64° 19’.51S, 62° 58’.6 W 
Charts: Inset plan on BA 3213 and DMA 29106
(Other possibilities recommended in NE wind are Andersen sound and the channel along the N side of 
Omega Island)

A favourite landfall/departure point because it 
offers secure shelter in most conditions, although it 
is somewhat open to NE swells. There are no local 
features of particular interest. Anchor off the dock 
in front of the Argentine base (not functioning 
in early January 2007) in c 8-10m. The creek is 
narrow between rocks and four shore-lines are 
recommended. Water available from stream off a 
snow bank at head of inlet.

Under spinnaker in the Drake Passage
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2. Cuverville Island
64°41’.31 S, 62°37’.75 W
Charts: DMA 29122 

The shelter among the low rocky islets is minimal 
but adequate. Icebergs lurk. The holding is not good. 
Lines can be taken to the eastern shore but the islets 
to the west are rather far. There are many penguin 
rookeries shown on plan in Oceanites Compendium.

Approach from N and anchor well into the bay on 
the E side of the Chilean base (hospitable staff; 
interesting visit) N of the isthmus, with 2 stern lines. 
A large gentoo penguin colony shares the base 
premises, apparently unconcerned. One can visit the 
protected historic site where two British scientists, 
Bagshawe and Lester, spent a year in 1921-22, living 
in a hut converted from a whaling ship’s ‘waterboat’. 

The bay on the southern side of the isthmus is 
reported to be secure in N or NE wind. The east side 
of the anchorage is part of the Peninsula, making 
this one of the few sites at which visitors can walk on 
the Antarctic Continent.

Gentoo feeding chick

3. Waterboat Point
64°49’.4S, 62°51’.3W 
Chart: DMA 29122
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4. Almirante Brown (South) 
64°54’ S, 62°51’.47W
Charts: DMA 29122

Bay opposite Bryde Island round the corner south 
and east of the Argentine Base, re-opened in 2007. 
Enter by keeping close to v. prominent isolated rock 
on E side. Anchor in c 10m in the middle of a pool 
surrounded on three sides by towering steep-sided 
glaciers, with long lines to shore on N side and to 
line of rocks to S. Sheltered from all directions but 
because of surrounding mountains probably gusty in 
strong winds. Water from stream on point on N side 
of bay.

5. Vernadsky Base
65°14’.82S, 64° 15’.09W
Charts: BA 3575

This was formerly the British ‘Faraday’ base, which 
passed to the Ukrainians in 1998. Treacherous 
approach to anchoring places. Enter via Meek 
channel, turn south in front of rock with sign-post 
and curve round into channel immediately by the 
landing dock on the S side of the base. In 2007 there 
were two orange plastic buoys marking the channel. 
But there are still unmarked rocks to avoid. Go very 
slowly!

The favoured anchorage is in the secluded notch 
in Stella Creek. Otherwise in the E part of the bay 
by the station. Can be very gusty. Take lines from all 
four corners. NB the rocks are crumbly.

Call the base - indeed any other base - on the VHF 
well ahead so that they can arrange a visit to fit in to 
their work and with the invasions from cruise ships. 
Sadko’s crew were invited over in the evening and 
the interesting tour of the former Faraday station 
ended in the bar with their home-brewed garyelka 
(a peppery vodka) The base-staff hold the key to the 
‘Wordie Hut’, a restored British base from the 1940s, 
built on winter Island where the British Graham Land 

Expedition (1934-37) made its base before moving 
south to Marguerite Bay. 
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6. Flounder Island
(Fish Islands) 
66°01’.59S, 65°24’.19W
Inset plan ‘Prospect Point’ 
on BA 3213 and DMA 29106

The inlet on the NW is open to the sea but is deeper 
and better-protected than suggested by the chart. 
It is easy to set a secure four-point tie with depth 
between 5 and 10m. Depending on the state of the 
tide, water may be collected from the low ice cliffs. 
NB: There may be a discouraging or prohibitive 
amount of ice; and it may move rapidly. There is a 
possible snow-climb on the overlooking hills, where 
charter-yacht punters go skiing.

Crossing the Antarctic Circle

7. Detaille Island
66°52’.07S, 66°47’.46W
Inset plan on BA 3213 and DMA 29106.

Striking situation. A former British base, abandoned 
“as was” in 1959 and now in a disgraceful state 
pending a decision whether to dismantle it or to 
restore it as a museum site. Meanwhile it offers a 
sad but fascinating visit.

In other than strong W or SW conditions the 
anchorage in 5-6m immediately below the base hut 
on the SW side offers good protection. Three lines 

Skuas on Detaille

can be taken at normal angles ashore and a fourth 
to exposed rocks on the west side. In strong SW 
wind the anchorage in the bay N of the base below 
a small hut has been recommended. (66º 51.98'S, 
66º 47.56'). But beware: the adjacent rock pools are 
shallow. 

The ice conditions change rapidly. In January 
2007 Sadko was beset for two days in the south 
side anchorage by floes of sea-ice which appeared 
overnight, but sailed off in open water the next day.
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Sadko at Detaille, from seaward Iced in at Detaille

8. Watkins Archipelago [?] 
66°23’.8 S, 67°09’.5 W
Chart: DMA 29127 

Largely uncharted waters. Recommended for 
adventurers with suitable boats.

There is a skein of closely-placed small islands, 
bulkier than would appear from the charts, between 
Watkins Island and Belding Island, with possible 
anchorages in the channels between them. Beware 
treacherous, uneven bottom. Sadko failed to find the 
spot recommended in Borrowed Notes but stayed 
peacefully in a notch on the N side of the most 
northerly channel to the E, below the wreckage of a - 
seemingly Polish - base. (GPS position above) Anchor 

in the channel (holding not proven) and drop back 
onto four lines. Expect plenty of ice moving with 
the current. There is an excellent watering-place 
opposite the base on the south side of the channel.

There is safe exit northwards into the Pacific via 
the deep-water anchorage shown on the DMA chart, 
but proceed very carefully over shallow patches 
around the northern mouth of the channel between 
the small islands and Belding Island.

Caution: details 
extremely sketchy
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 9. Duchaylard Island
‘Duff Cove’ 
(apparently so-called after the nick-name ‘Plum Duff’ for the 555m conical mountain towering above) 
65°43’.71S, 65°05’.81W
Chart: DMA 29127

This is not a secure anchorage but offers shelter 
from about SW to NNE within a semi-circle of ice-
cliffs, and is attractive in settled weather.

The slot recommended in Borrowed Notes 
between the low islet and the W shore may be 
unusable because of dangerous overhanging ice on 
the cliffs. Sadko preferred to anchor S of the islet 
(successful holding) in about 20 m and to take two 
stern lines to the islet. Pitons required. Beware of 
large waves from ice-falls when ashore.  A limited 
ramble ashore can be had by taking the dinghy to 
the low isthmus to the NE.

10. Lippmann Islands
65°30’.51S, 64°24’.9W
Charts: DMA 29127 
See plans based on arrival/departure waypoints 
and on survey of the anchorage by dinghy. 

Useful pit-stop off the Grandidier Channel, in a rock-
pool well-sheltered except from due E although 
there may be much ice.

Recent chart editions show the line of rocks and 
shallows reaching eastwards from the south of the 
islands. It appears that others have found their way 
through them and entered the anchorage over the 
shallow sill immediately E of the anchorage. But the 
route shown on the sketch is more comfortable.

Note: going north
The area west of the chain of islands from 

Splitwind Island to the southern end of Hovgaard 
inclusive is shown on the charts as ‘Unsurveyed’ but, 
with an eye on the depth-sounder, there is plenty 
of water for a coastal passage to the following two 
places, approaching from N or from S.
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11. Hovgaard/Florence
65°06’.49S, 64°05’.01W
Charts: BA 3572 and 3575

The narrow gut between Hovgaard and Florence 
Island is well sheltered for almost any conditions, 
with plenty of places to take lines ashore. The E end 
is foul so enter from the west, passing S of the first 
rock shown into something of a pool and anchor in 
5-6m. The shallowest depth found in the approach 
was 3m so the anchorage can probably be entered 
by most yachts at any stage of the tide.
In the SE corner of the bay to the N of Florence 
Island is an excellent anchoring spot where there 
are stainless steel bollards on both N and S shores. 
Northern Light wintered here in the 1980s. Abundant 
water for washing (only) from waterfall on Pleneau. 
Excellent rambles on Pleneau (penguin colony) and 
Hovgaard islands. Skiing possible.

12. Booth Island – Cholet
65°03’.68S, 64°01’.94W
Chart BA 3575

Just off the northern shore of Booth Island beneath 
the beacon is a good anchorage on Cholet, a 
crescent-shaped islet. The enclosed bay is longer 
and narrower that appears from the charts. There is 
10m depth well into the anchorage and lines can be 
taken ashore from all corners. The open end of the 
bay is partly sheltered from SW by the N shore of 
Booth Island, but ice can come in quickly.

13. Port Lockroy
64°49’.4S, 63°28’.9W
(Inset plan on BA 3213 and DMA 29106)

A near-obligatory visit. This small former British base 
is run during the season by the UK Antarctic Heritage 
Trust as a visitor centre and museum with a working 
‘EIIR’ Post Office. In normal conditions it is easiest to 
lie at anchor in the middle of the well-sheltered bay, 
somewhere near where the chart indicates ‘Mud’ in 
around 20 m. For more shelter, depending on the 
wind direction, there are established notches – not 
sampled by Sadko - in Alice Creek, at the S end of 

the bay, and outside the bay in Dorian cove and E of 
Jougla Point. 
NB: To visit the station from the bay go E of Doudier 
Island to the landing stage on the S side. (Access via 
the creek between the two islands is very rocky and 
involves tramping through a penguin colony) Contact 
the station in advance to arrange a visit because the 
cruise ship traffic is heavy (15,000 visitors in the 
2006/7 season)
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14. Enterprise Island
64°32’.4S, 61°59’.9W
Charts: BA 3566 DMA 29122

An excellent, all-weather way-station in the Gerlache 
strait. Approach from just S of E and tie alongside 
the decaying hulk of a whaling ship, with lines to 
the bollard and/or rocks on shore, if there was much 
swell. Antarctic Terns think that they own the wreck, 
but there is little other wild-life. The wreck itself 
is interesting industrial archaeology and a limited 
ramble on the beach is possible.

15. Deception Island
Chart: BA 3202 (But beware: outdated editions 
do not show the changes to the shoreline fol-
lowing more recent volcanic activity)

Massive volcanic crater lake. The original centre of 
commercial activity and exploration in the Peninsula 
area. Although much of the past has been destroyed 
in volcanic eruptions, the Oceanites Compendium 
identifies five sites of historical or wildlife interest. 
Entry through Neptune’s Bellows: the following GPS 
point S of South East Point will enable one to pick 
up on the entry directions in the Admiralty Pilot: 62º 
59.7’S, 60º 31.3’W. 
Caution: Ravn rock (unmarked) lies just south of the 
channel and was struck by a cruise-ship in February 
2007. If in doubt tend to starboard. Shelter should 
be found somewhere in the crater in almost any 
conditions; the most secure recommended bolt-
hole being Telefon Bay in the north-east corner. (Not 
visited by Sadko) 

Crabeater seal

Whalers Bay 
62°58’.96S, 60°34’.04W

Pendulum Cove 
62°56’.19S, 60°36’.05W

An open anchorage with good holding. Although it 
is well-sheltered from the sea the wind can whistle 
down from the surrounding mountains. The sea-bed 
shallows well offshore so anchor in say 20m in case 
of a wind-shift. Remains of whaling and scientific 
stations; good walk up to ‘Neptune’s Window’.

Four miles further north, has more shelter and good 
holding. But swinging space is limited, indicating 
shore lines or a second anchor in unsettled weather. 
In both anchorages volcanic pools on the shore can 
be enlarged to provide hot paddling/bathing!
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16. Potter Cove 
King George Island
62°14’.15S, 58°40’.5W
Chart: Inset on BA 1774

17. Admiralty Bay 
Ezcurra Inlet
62°10’.15S, 58°34’.48W
Chart: Inset on BA 1774

18. Elephant Island
Point Wild, 62°06’ S, 54°52’W
Chart: DMA 29104 Sketch map 18

Excellent shelter in the bay. Good holding in 10-15m 
behind the point on the E entrance, in front of the 
Argentine ‘Jubany’ base. The base’s reputation for 
hospitality was amply justified in 2007 with pressing 
invitations to meals, showers, laundry facilities, and 
access to their fresh water supply. Otherwise there 
is little for the tourist because the site is adjacent 
to a Protected Area and wandering around is not 
allowed.

Access is straight forward. The following approach 
waypoint in the entrance to the bay favours the 
western shore in order to clear foul ground on 
eastern side: 62º 14.5’ S, 58º 40.5’W

(GPS positions appear to be about 0.4M N of charted 
positions)
Note that the whole of Admiralty Bay is a ‘Managed 
area’ under the regime of the Antarctic Treaty.

Well-sheltered spot between Dufayel Island 
and the point at the head of the inlet, surrounded 
by spectacular glaciers. Anchorage found in 15-20 
metres, good holding, a cable or two NW of the 
anchor shown on the chart. Clean water is available 
from glacier run-offs on the south side of the inlet. 
Fur seals on beach.

For those interested in the history of Shackleton’s 
expedition, a visit to the spot where 22 of its 
members survived for four months in 1916 is a 
compelling pilgrimage. Shore-access is difficult and 
the Oceanites Compendium indicates that the norm 
is to sight-see from a Zodiac off-shore.

The ‘beach’ is a fringe of rounded boulders. 
Landing is possible on the rare occasions when one 
or more of these rocks can be used as a landing 
stage during gaps in the surf. Wet suits or waders 
recommended. 

The spit is heavily colonized by penguins and fur 
seals. Both populations object vociferously to 
intruders. Around the Chilean memorial in the 
middle of the isthmus neither group is actively 
aggressive, but it seems prudent not to disturb the 
seals by pushing one’s way the 100m or so to the 
presumed site of the famous ‘boat-hut’ on the north 
side of the spit. 

Approach: The above waypoint is accurate for 
the actual site. An approach waypoint of 62º 05.2’ 
S, 54º 52’W permits one to enter the bay from due 
N. Anchoring is not recommended (and may be 
impossible) but there is plenty of space to circle 
quietly in the bay in 15-20m, roughly level with 
the gap between Penguin Hill and Gnomon Island 
(79m – erroneously shown as a mere rock (‘+’) on 
the DMA chart) while a tender and/or shore-party 
explore. The E side of the bay near the point appears 
to be deeper than the western (Cape Belsham) side. 
Note that the historic site may not be immediately 
identified from seaward. It is more closely wedged 
between high rock and cliff than one would expect 
from some of Frank Hurley’s famous photographs, in 
which the terrain looks more open.
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Site of old boatyard, Point Wild

The RCC Pilotage Foundation is a non profit making voluntary organisation.

The object of the Foundation shall be to collect and research information relating to small boat 
pilotage (including information relating to remoter areas where other sources of information are 
scarce or non-existent) and to disseminate this information through the production of books, charts, 
lectures, meetings, internet or such other media or means as may be appropriate” information is part 
of a series made available to yachtsmen on 

The products of the Pilotage Foundation, including books, web pilots, book support files and Passage 
Planning Guides may be seen on www.rccpf.org.uk.   The Foundation welcomes contributions from 
cruising yachtsmen.  Contact detail may be found on the website.

About Us Pete Hill Noel Marshall
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Page	Navigation	Panel
Simply click on the Navigation Panel icon, then click on the required page thumbnail.
To hide the Page Navigation, simply click on the Pages icon once again.

To adjust the way navigation pages are displayed, click on the options icon to display options.

Bookmarks Panel
Simply click on the Bookmarks Panel icon, then click on the required bookmark
To hide the bookmarks, simply click on the bookmark icon once again.

To adjust the way bookmarks are displayed, click on the options icon to display options.

Changing the way the document is displayed
You can use the following page layouts when viewing this document using  View > Page Display :
Single Page : Displays one page at a time, with no portion on other pages visible
Single Page Continuous : Displays pages in a continuous vertical 
column that is one page wide
Two-up : Displays each two-page spread with no portion of other 
pages visible
Two-up Continuous : Displays facing pages side by side in a contuous 
vertical column

To display the first page of a multi-page document alone on the 
right side, firstly specify the Two-up or Two-up Continuous option. 
Then choose View > Page Display > Show Cover Page During Two-up

Page	Display	Options

Navigation	Panel	Options

HOW TO USE THIS DOCUMENT

Default Document Display Format

This document will open, by default, with the “Single page continuous” page display, and with the Bookmarks 
panel automatically showing.
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Go to the next Page
Moving to the next page can be achieved by any of the following :
Press the Page Down key
Click on the next page icon
Enter the required page number in the input box
Click on the Document bar along the right handside of the screen.
Zooming into a page
If you wish to see a page in greater detail, you can use the percentage drop-down icon in the main toolbar.  
This provides a number of default zoom-level options.
Once zoomed in, to move the document, hold the left-hand mouse button. Your cursor will change to a 
clenched fist. This will allow you to drag the document to the right position.
Opening and Closing “Reading Mode”
The reading mode hides everything in the page display except the document itself and the menu bar.
Choose View > Reading Mode
Choose Reading Mode again restores the previous view, with the same navigation displays and toolbar 
displays.
Automatic	scrolling	through	the	document
To automatically scroll through a document, choose View > Automatic Scroll
Press the Esc key to stop the scrolling
View the document in “Full screen mode”
In Full Screen Mode, the document pages fill the entire screen
View > Full Screen Mode
To go to the next page, press Enter, Page Down, or Right Arrow key, or click the next page icon
Setting	PDF	Document	Display	Preferences
You can set your preferences for reading PDF documents by going to :
Edit > Preferences
In particular set :
Edit > preferences > Full Screen and check the “Show Navigation Bar” option
Edit > preferences > Page Display and set your preferred Default Layout and Zoom options

Next Page

HOW TO USE THIS DOCUMENT (2)

Changing	the	Toolbar	icon	options

To add or remove icons from the toolbar, choose Tools > Customise Toolbars

Where the document contains a reference to an external website, the link will be active and by clicking on it, 
will open your web browser on that page (assuming you have access to the internet).

Interactive	Table	of	Contents

Hyperlinks

This document has been prepared with an interactive Table of Contents. Simply click on the section of the 
document that you wish to view.

Interactive	plans

Some plans in the document are interactive in that by positioning your mouse over the plan, it will be displayed 
in a bigger format to allow easier viewing. Interactive plans can be recognised by the following icon seen in 
the corner.

icon designed by  Fat Cow Web Hosting

http://www.fatcow.com/
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This document has been prepared so that you can add your own comments and notes to the document.

First open up the Comment & markup Toolbar : Tools > Comment & Markup. Note the option to “Show 
Comment & Markup Toolbar” at the bottom of the options

OR click on: View > Toolbars > Comment & Markup to show the toolbar

Use the various tools to annotate your document. These include sticky notes, lines, arrows, etc.

Before closing the document, you will be presented with the option to Save your changes to the document. 
Answer “yes” to retain your comments.

To view all comments added in the document, click on the Comments icon (on lower lefthand side of screen).

Sending a copy of your comments to RCCPF
To send a copy of all your comments to RCCPF then open up the Comments Panel using the comments icon.

Then click on the options icon.

Then select the “Export Selected Comments...” option. This will prompt you to save a file (with a .fdf file 
extension).
You then need to e-mail this file to RCCPF indicating to which RCCPF ebook they refer.

The document has a full text search capability allowing you to find any specific word in the document. Simply 
enter the required word into the “Find” box in the toolbar and press enter.

If the word occurs more than once, the next word icon is displayed. Just click to go to the next occurence of 
the word.

This document can be prepared to allow you to print all, or a subset, of the pages.
File > Print...

Google maps

HOW TO USE THIS DOCUMENT (3)

Searching	the	document	for	specific	words

Adding	comments	&	sticky	notes	to	your	PDF	document

Google maps Links

On the header of each section, there is an active link to the appropriate map, courtesy of Google Maps. Just 
click on the pin to access the appropriate map. On accessing the map, select the location,
then select the “zoom to” option.

Printing	the	document

mailto:feedback%40rccpf.org.uk?subject=
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If updates are received, then press the button below to retrieve them:

Send your feedback, comments or suggestions by using the main feedback form on the RCCPF website:

Or email your feedback to us:

Or mail to the registered address at :

RCCPF
Armaside
Lorton
Cockermouth
Cumbria
CA13 9TL

If you wish to send a copy of the various comments you may have annotated on your copy of this book, then 
this can achieved relatively easily. See the “Sending a copy of your comments to RCCPF” instructions on the 
opposite page.

FEEDBACK TO THE RCC PILOTAGE FOUNDATION

Mid-season Updates

http://www.rccpf.org.uk/easyzip/mailer.html
mailto:feedback%40rccpf.org.uk?subject=
mailto:feedback@rccpf.demon.co.uk
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